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RocketPort® and RocketModem Series Driver 
Installation with Windows® 2000

How to Use this Document
You can use the interactive Table of Contents to locate the information you need.  

Driver Requirements
This document discusses installing and configuring the RocketPort and RocketModem device driver for the 
Windows 2000 operating system. The RocketPort or RocketModem requires at least one host server running 
Windows® 2000.
Note: This driver supports only one ISA adapter.
For hardware specific information or the product overview, see the Hardware Installation documentation that 
is available on the Comtrol media (diskette or CD) shipped with your product or download the current version 
from the ftp/web site. 
Driver updates can be downloaded at no charge from the Comtrol ftp/web site. Always check the web or ftp 
sites to make sure that you have the current driver and documentation. Software downloaded from the ftp/
web site are self-extracting zipped files that you must extract before installing.

Driver Features
This driver has the following features:
• Can be installed on multiple servers.
• Supports up to 128 RocketPort or RocketModem ports per server.

Note: The critical limit is the number of ports your server can support. In most applications, this is 
defined by the number of RAS port supported, which is typically 256 ports per primary server.

• Allows you to inter-mix RocketPort and RocketModem ports.

Upgrading from Windows 95/98 or Windows NT
If you are upgrading from another operating system, follow these steps:
Note: Do not use the Update Driver feature in the Device Manager to upgrade the driver.
1. Remove the driver from the Windows 95/98 or Windows NT operating system following the procedures 

outlined in that software installation documentation.
2. Turn off the system, remove the boards, and set them aside.
3. Upgrade your system to Windows 2000.
4. Install the adapters and turn on the system. If one is an ISA adapter, set the DIP switch. This driver 

supports only one ISA adapter.
Note: If you need information about re-installing adapters, see the Hardware Installation documentation. 

5. Use the Installing the Driver and Removing or Disabling the Adapter in Windows 2000 subsections to set 
up the new driver.

www.comtrol.com
ftp://ftp.comtrol.com

http://www.comtrol.com
ftp://ftp.comtrol.com/readme.htm
http://www.comtrol.com/coperate#download
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Removing or Disabling the Adapter in Windows 2000
Adapters cannot be removed through the Main Setup window. Use the following procedure to remove 
adapters:
1. On the Windows desktop, right-click on the My Computer  icon and select Manage.
2. Double-click on the Device Manager.
3. Open the Multi-port serial adapters  entry (click the [+] button to expand the list).
4. Right-click on the adapter you want to disable or uninstall.
5. Select on of the following:

• Disable to disable the device in the current hardware profile but not remove it. To update the driver 
from the ftp/web site, you must first Disable the driver and then use the Device Manager to Update the 
driver.

• Uninstall to completely remove the adapter.
• Properties to display the Device Properties window.
Note: If you prefer, you can disable or enable the adapter by changing the Device Usage field on the Device 

Properties window, General tab.
6. Exit the Device Manager window and resume normal operations.

Installing the Driver
Adapters cannot be added through the Device Manager or Main Setup window. 

PCI Adapters
The computer's Plug and Play feature should recognize the PCI-bus adapters, which should automatically 
launch the Add/Remove Hardware wizard. If Windows 2000 does not recognize your PCI adapter, or if you 
have installed an ISA-bus, follow the procedure below.
To install the driver for a PCI adapter, install the adapter using the hardware installation documentation. 
The system should automatically install the driver. You may need to configure device or port properties.
If you want to upgrade to the latest driver from the ftp site, upgrade the driver before configuring the device 
or port properties. 

ISA Adapters
Before installing the driver, you should install the hardware and restart the system. To install the driver, use 
the Add/Remove Hardware wizard. 
Note: This driver only supports one ISA adapter. If installing an ISA board, you must set the I/O DIP switch 

and you may need to change the software setting. See Setting I/O Addresses and DIP Switches (ISA 
Only), if necessary. 

1. On the Windows desktop, right-click the My Computer icon.
2. Click Properties.
3. Select the Hardware tab.
4. Select the Hardware Wizard  button.
5. Select the Next button when the Add/Remove Hardware wizard appears.
6. Select the Add/Troubleshoot a device option and the Next button.
7. Select the Add a new device option and the Next button.
8. Select the No, I want to select the hardware from a list option and the Next button.
9. Highlight Multi-port serial adapters  when asked to choose the type of hardware to install and the Next 

button. 
Note: All Comtrol products are considered multi-port serial adapters.
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10. Select Comtrol Corporation  as the manufacturer, the appropriate Comtrol product  you wish to install, and 
the Next button.

11. Select the Next button at the Start Hardware Installation screen.
Note: It may take up to several minutes for Windows 2000 to load the driver.

12. Select the Finish button to complete the driver installation process.
After you complete driver installation, additional steps may be necessary to configure the ports through the 
Main Setup tab.
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Upgrading the Driver
Use this procedure if you want to upgrade the driver in the Windows 2000 operating system. An upgraded 
driver may be available from the following:
• Downloaded from the Comtrol ftp/web site.
• Contained on Comtrol media shipped with the product.
Before you can install a more current version of the driver, first remove the existing driver and the adapter. 
Use the following procedure to install a new driver:
1. Unzip the file into a new subdirectory, for example: \Comtrol .
2. On the Windows desktop, right-click on the My Computer icon and select Manage.
3. Double-click on the Device Manager.
4. Open the Multi-port serial adapters  item.
5. Highlight the device for which you want to update the driver, right-click, and select Disable. 

Note: All Comtrol products are considered multi-port serial adapters.

6. Select Yes when this pop screen appears:

7. Double-click on the disabled device and select the Driver  tab.
8. Select the Update Driver button.
Upgrading the Driver 5 



9. Select the Next button to start the Upgrade Driver wizard.

10. Select the Display a list of the known drivers for this device so that I can choose a specific button and the Next 
button.
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11. Select the Have Disk button, browse to the location of the driver file that you extracted, and then select the 
Ok button.

12. Highlight the device and select the Next button to install the driver with the default settings.
13. Select Yes to the Update Driver Warning popup window.

14. Select the Next button at the Install Device Driver screen.
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15. Select Yes at the “Digital Signature Not Found” popup screen.

16. Select the Finish button to complete the driver installation process.
17. Select the Close button when you return to the Properties screen.
18. Select Yes to this popup screen to restart your system.

After you complete driver installation, additional steps may be necessary to configure the ports through the 
Main Setup tab.
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Accessing the Main Setup Tab
1. On the Windows desktop, right-click the My Computer icon and select Manage.
2. Double-click on the Device Manager.
3. Click the [+] button for the adapter under Multi-port serial adapters to expand the view.
4. Highlight the adapter that you want to access.
5. Select Action --> Properties.
6. Select the Main Setup tab.

Note: For information on using port options, use the context-sensitive help in the Main Setup or Options 
screens.
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Changing Device Properties
You can change the following device properties:
• Device name
• Starting COM port number.
To change device properties, follow this procedure to access the Device Setup tab:
1. Access the Main Setup screen. 
2. Highlight the device name and select Properties.
3. After making your changes, select the Ok 

button and follow any other driver prompts.
Note: Use the Help button if you need detailed 

information about procedures or use 
context-sensitive help for any field.
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Configuring Device Properties
You can optionally configure the following 
Device Properties:
• Verbose event log for diagnostic purposes.
• Scan rate to adjust latency for timing-

critical applications.
• Enable RS-485 mode.
Use the following procedure:
1. Access the Main Setup screen. 
2. Select the Options tab.
3. Enable the features you want to use.
4. If you enable the RS-485 feature, an RS485 

tab appears behind the COM Port 
Properties tab that you may need to 
configure.
Note: Use the Help button if you need 

detailed information about 
procedures or use context-sensitive 
help for any field.

Configuring Port Properties
You can also configure specific port properties for this 
adapter:
• Override and lock baud rate
• Timeout on transmit data
• Map CD to DSR
• Map 2 stop bits to 1
• Wait on physical transmission
• Emulate modem hardware RING signal
• Clone all Comtrol ports for this server
Use the following procedure to access the Port 
Properties tab:
1. Access the Main Setup screen. 
2. Highlight the port you want to configure and 

select the Properties button.
3. Enable the features you want to use and select the 

OK  button. To configure all ports on the adapter 
with the same features, select Clone.
Note: Use the Help button if you need detailed 

information about procedures or use 
context-sensitive help for any field.

Adding Additional Adapters
Install the adapter and  configure the ports.
Note: This driver supports only one ISA adapter.
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Troubleshooting 
If you are having trouble with a RocketPort or RocketModem, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling or network problems.
1. Verify that you are using the correct types of cables in the correct places and that all cables are tightly 

connected.
2. If ISA, make sure that you set the I/O DIP switch correctly.
3. Enable the Verbose Event Log feature under the Setup Options tab and then reboot the server.
4. Verify that you are addressing the port correctly. In many applications, device names above COM9 require 

the prefix \\.\ to be recognized. For example, to reference COM20, use \\.\COM20 as the file or port name.
5. Use the Test Terminal program (wcom32.exe) to troubleshoot communications on a port-by-port basis.
6. Use the Port Monitor program (portmon.exe) to check for errors, modem control, and status signals. In 

addition, it provides you with raw byte input and output counts.
7. Use the Peer Tracer program (peer.exe) to trace driver events.
8. Remove and reinstall the latest released driver from the ftp site.

Adding a Program Group Under the Start Button
Perform the following procedure if you want to add a program group under your Start button.
1. Access the Main Setup screen, highlight the adapter and select the Properties button.
2. Change the name of the adapter or change a parameter and select the Ok button.

Note: Changing the adapter name in the Main Setup screen does not change the device’s name in the 
Device Manager. If necessary, reset the parameter back to it’s original value after completing Step 4.

3. Select Yes when this popup screen appears:

4. Close the Program group. Now it will appear under the Start ---> Programs button.

Using Test Terminal
WCOM32 is a terminal program that enables you to open a port, send characters and commands to the port, 
and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is running or any other 

application is using the port. If you are using RAS, you must stop the service before starting WCOM32 
to test RAS COM ports. To test ports that are not used by RAS, you do not need to stop RAS.
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1. To start WCOM32, select Test Terminal from the Comtrol program group. The program window displays: 

2. Select Open Port from the Port menu. A list of possible COM port numbers displays.
3. Select the COM port you want to test.

If the COM port does not exist or if it is currently being used by another program, a Create File Error 
message displays.
If the COM port is available, a terminal window pops up:   

Note: Notice the <loop> button in the terminal window. If this option is activated, it is green and uppercase 
( ), the COM port internal loopback feature is activated, and the data is returned by the COM port 
hardware. If this option is deactivated, it is gray and lowercase ( ), the internal loopback is 
deactivated, and the data is sent out the COM port.

Testing a RocketPort
Use the following procedure to test a port.
Note: RocketModem: use the subsection called Testing a RocketModem
1. Place a loopback plug on the COM port you are testing. Make sure all connectors are seated firmly and that 

the loop button is off. 
2. From the Port menu, select Send Test Data. The program sends out a repeating data stream. 

Note: To stop the data stream, select Send Test Data again. 
• If the loopback plug is in place and the port is working correctly, the test data should be echoed back 

to the screen. 
• If the loopback plug is not in place or the port is not working correctly, no data or garbled data is echoed 

back to the screen. 
Note: If no characters appear, try putting the loopback plug on an adjacent port. It may be that you have 

the ports mixed up. 
3. If further testing is required, select Loopback Test from the Port menu. If the loopback plug is in place and 

the port is working correctly, the system should return the message “Passed.”
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If the loopback plug is not in place or the port is not working correctly, the system will return the message 
“Failed.” 

4. If the port has failed in Step 2 or 3, and the RocketPort is equipped with an external interface box or fan-
out cable, click the loop button to switch the internal loopback feature on. 

5. Repeat Steps 2 and 3. If the port now passes the tests, the fault may lie in the interface box or fan-out 
cable. Contact Comtrol technical support for more assistance. 

Testing a RocketModem
The following test may be used to ensure functionality of the RocketModem.
Note: Make sure the loop button is off for the following tests.
Test 1: The following steps check to see if the modem responds.
1. Type atz. This should return an OK.
2. Type at&v. This should display the modem configuration.
Test 2: The following test calls from the modem to an ordinary telephone.
1. Connect the modem to a phone line.
2. Enter atdtphonenumber. The telephone should ring.

Where phonenumber is the phone number of an ordinary telephone. 
Test 3: This example has one modem call another modem.
1. Enter +++ath to hang up.
2. Connect two modems to phone lines, open two Test Terminal sessions, and use one modem to call the 

other. Send typed characters from one modem to the other.
Test 4: You can call into a host system and use Test Terminal to emulate an ANSI terminal session.

Modem Control Signals 
The terminal window displays the modem control signals as gray or green lights at the top of the window. The 
first four are inputs: 

The lights are green if they are turned on, or gray if off. The text on the light also changes from uppercase 
(CTS), which is on, to lowercase (cts), which is off.
Note: Ring Indicator (RI) is available on the RocketPort Plus only.
The next two lights are outputs:  
Note: RocketPort: If you have a loopback plug connected and you click on one of the outputs, the 

corresponding signal is sent to the input and the input lights should toggle accordingly.

You can use RTS and DTR to send flow-control signals to the modem. However, this does not register on 
the input lights.

The rightmost light is the loop indicator:  
If this is on, the COM port internal loopback feature is activated and any information or code entered in the 
terminal window loops back through the COM port circuitry. If this is off, the COM port internal loopback is 
deactivated, and any information or code entered in the terminal window is sent out of the port.

Using Port Monitor
The Port Monitor program (portmon.exe) offers a summary of all RocketPort or RocketModem statistics in one 
spreadsheet view. It also enables you to verify operation of all RocketPort or RocketModem ports from a 
single window. 
The Port Monitor display follows the familiar spreadsheet model: each COM port is a horizontal row, and each 
vertical column displays a variable or value for the respective COM port. For definitions of the abbreviations 
used, see the Port Monitor Variable List.
Port Monitor can also produce statistics and reports that can help you verify the operation of the COM ports 
and connected peripherals. 
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Some immediate feedback includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from the driver
• Port errors
The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can cover all ports collectively or 
a separate report for each port. You can also set how often the values are recalculated, fine-tuning 
thoroughness against system efficiency, and automatically run external batch files to perform additional 
processing and analysis.

Starting Port Monitor
To run Port Monitor, select Port Monitor  from the Comtrol program group. 
The monitor window displays:
Note: To change the appearance of the screen, see 

the following discussion.
Once the monitor window displays, Port Monitor 
is active and collecting data. If any cumulative 
data has been saved from previous sessions, it is 
automatically brought in and used.
Port Monitor continues to run and collect data 
until you terminate it, at which point all 
accumulated data is automatically saved for use 
in the next session.

Changing Screen Appearance
While Port Monitor is running, there are a number of commands and controls that change the appearance of 
the screen.

Port Monitor Screen Commands 

Desired Change Procedure

Change the monitor window font. Select Font from the Edit  menu.

Change width of a single column. Left-click on the column separator (vertical) line and drag it to the 
desired width.

Change column placement. Left-click in the middle of the column you want to move and drag it to the 
desired location.

Remove a column. Right-click on the column you want to remove and select Remove from the 
pop-up menu.

Clear all fields and reset them to 
null values.

Right-click on the upper left cell in the table and select Reset from the 
pop-up menu.*

Clear any single field except the 
upper left cell.

Right-click on the field to be cleared and select Reset from the pop-up 
menu.*

Add a column.

Right-click on the column now occupying the desired location and select 
Add from the pop-up menu. You are prompted to name the variable you 
want to display, as well as other information. (See Column Setup, below.) 
After you click OK , the column is inserted in the selected location and the 
existing column is moved to the right.

Change other properties of a 
column.

Right-click on the column and select Properties from the pop-up menu. 
(See Column Setup, below.)
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* The Reset command does not clear raw data from the calcs.dat file. It simply resets the selected display fields 
to their null values. For more information regarding calcs.dat see page 17.

Column Setup
When you select Add or Properties from the column pop-up menu, the Column Setup window displays: 

• Use the Input  droplist to select the variable displayed in the column.
• Use the Type droplist to select the way in which the value displays: either as an integer, as an on/off state, 

as an integer with a kilo, mega, or giga suffix, or as an hh:mm:ss time stamp. This defaults to the 
appropriate type for the selected Input variable.

• Use the Name variable to change the column heading name.
• Use the Width  variable to specify the column width in characters.
• Use Color0 to set the column character color when the value is zero.
• Use Color1 to set the column character color when the value is not zero.
• When done, click OK  to save your changes and return to Port Monitor.

Report Configuration
To configure reports, select Config from the Edit 
menu. 
The Single report options cover all ports and are 
overwritten each time the reports are generated. 
The Multiple  report options generate a separate 
report for each port, and each report file is 
appended each time the report is generated.
For Hour  reports, use the Single and Multiple 
droplists to select whether you are generating 
single or multiple reports, or both. For each report 
type, select from the following types of data to 
include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the 

name are included.
• All Data: all variables are included.
• View Data: only variables that appear on-

screen are included.
The External Program field is used to enter a command line to run another program after the hourly reports 
have been generated. For example, you can use this to run a batch file that performs custom report 
processing. The Test button causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your choices are:
• None: no report is generated.
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• Day Data: only variables with the words “Day” or “Raw” in the names are included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor window are included.
Likewise, the External Program field is used to enter a command line to be executed after the daily reports 
have been generated.
The Update Time option allows you to set the rate at which the port information is obtained and the 
calculations performed. There is a trade-off between Port Monitor efficiency and response time. If you are 
using Port Monitor to view the port activity on the screen, you may want to set the update time to 1 or 2 
seconds, so that the screen is updated frequently. If you are concerned about the monitor program using CPU 
resources, set this to a higher value, (6 to 20 seconds) in order to decrease the time required by the program to 
perform the calculations and update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the display area of the program will 
help reduce the CPU overhead of updating the screen.

Port Monitor Files
Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting with the appearance of the 
monitor screen, you can use the File menu Save option to save your customized layout in another.vew file. You 
can retrieve this file later by using the File menu Open option, or you can use the Edit menu View Default 
option to retrieve portmon.vew and restore the default view.
All Port Monitor calculations are saved at program exit and on the hour in a binary file named calcs.dat. This 
enables you to halt Port Monitor execution without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are saved in this directory, 
under the following names:
• hall.txt  — hourly single report
• dall.txt  — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the multiple report files grow in 

size. It is up to you to delete them periodically.
Some safeguards are built into the program to avoid filling up a hard disk drive due to growing report files. 
The monitoring program stops writing additional data to the multiple reports if they reach a size of 2 MB. 
Also, the program will not write out data files to the disk drive if the spare room on the drive is less than 2 
MB in size.
To view or edit an hourly or daily report, use the Edit Report option on the File menu, or use a system tool 
such as NOTEPAD.
For more information, see the Port Monitor Help file.

Port Monitor Variables 
The following table lists Port Monitor variables. 

Port Monitor Variable List 

Variable Description

Cd Input CD (carrier detect) pin status.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDDayRunTime Time in seconds carrier detect has been on in the last day.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

CDHourRunTime Time in seconds carrier detect has been on in the last hour.
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CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDRuns Carrier detect turn-on count.

CDRunTime Time in seconds carrier detect has been on.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Dtr Output DTR pin status.

Errors Total hardware receive errors (parity, framing, and overruns.)

FramingErrors Total count of receive framing errors.

FramingErrorsRaw Total count of receive framing errors, from the driver.

Open Open status, on if open, off if closed.

OverrunErrors Total count of receive overrun errors.

OverrunErrorsRaw Total count of receive overrun errors, from the driver.

ParityErrors Total count of receive parity errors.

ParityErrorsRaw Total count of receive parity errors, from the driver.

Rts Output RTS pin status.

RxCPSDayAvMax Peak RxMinCPS for the last day.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSInst Instantaneous average of receive characters per second.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxDayCnt Receive bytes count sent in the last day.

RxDayCntWrk Receive bytes count sent in this day.

RxHourCnt Receive bytes count sent in the last hour.

RxHourCntWrk Receive bytes count sent in this hour.

RxMinCnt Receive bytes count sent in the last minute.

RxMinCntWrk Receive bytes count sent in this minute.

RxMinCPS Last minute average of receive characters per second.

RxPkts Raw count of total receive packets sent.

RxTotal Total bytes received.

RxTotalRaw Total number of receive bytes raw data from the driver.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxCPSDayAvMax Peak TxMinCPS for the last day.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSInst Instantaneous average of transmit characters per second.

Port Monitor Variable List (Continued)

Variable Description
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Using Peer Tracer
The Peer Tracer program (peer.exe) is specifically designed to view the internal operations of the driver for the 
purpose of troubleshooting communications on Windows 2000 systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and receive text information to 
and from the driver. To use Peer, you type in commands, and status and information are sent back. Unlike 
Test Terminal, Peer enables you to keep a continuous log of the commands sent and the results received in a 
file named peer.log. 
Comtrol Technical Support may ask you to run Peer in order to help diagnose reported problems.

Starting Peer
Peer Tracer does not appear in the Comtrol 
program group. To use it, you must open Windows 
Explorer , access the C:\WINDOWS\system32\ 
directory, and double-click on peer.exe. The Peer 
Tracer window displays: 

Log Functions
All logging functions are found under the File 
menu. To start keeping a log, select Log to Disk from 
the File menu. The other options on this menu are 
View Disk Log, Clear Disk Log, Clear Screen, and Exit.

Using Peer
To use peer, simply type in commands at the : prompt. (It may be necessary to press Enter to make the : 
prompt appear.) For example, to examine COM5, type:

PORT COM5 <Enter>

To gather some information about the port, type:
STAT <Enter>

This should return details about the port.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxDayCnt Transmit bytes count sent in the last day.

TxDayCntWrk Transmit bytes count sent in this day.

TxHourCnt Transmit bytes count sent in the last hour.

TxHourCntWrk Transmit bytes count sent in this hour.

TxMinCnt Count of transmit bytes sent in last minute.

TxMinCntWrk Transmit bytes count sent in this minute.

TxMinCPS Last minute average of transmit characters per second.

TxPkts Raw count of total transmit packets sent.

TxTotal Total bytes transmitted.

TxTotalRaw Total number of transmit bytes raw data from the driver.

Port Monitor Variable List (Continued)

Variable Description
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To turn on monitoring of any calls into driver (events), type:
MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send “ATH0” to a modem—type:
SEND ATH0 <Enter>

A return and linefeed are always appended to each string sent.

Other Commands
Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in the driver, and that Peer simply acts as a conduit for this 
information. For more information, see the Peer.hlp help file.

Note: Use the Help button if you need detailed information about any field.

Setting I/O Addresses and DIP Switches (ISA Only)
This discussion concerns ISA-bus adapters only. This driver supports only one ISA adapter. When you install 
an ISA-bus adapter, you must set the base I/O address in two places:
• In the driver software.
• On the adapter itself, using a block of DIP switches.
Note: PCI-bus adapters use base I/O addresses that are assigned by the system BIOS. As a rule, you cannot 

change these addresses.

Software I/O Address
During installation, the software base I/O address is set to default values by the Add/Remove Hardware 
wizard.
After you finish the software installation, you can use the Device Properties Resources tab to view or change the 
Input/Output Range resource setting. If the default values prove incorrect:
1. Highlight the Input/Output Range from the Resource Type list.
2. Click the Change Setting button. 
3. You may need to choose a hardware configuration from the Setting Based On droplist to activate the Edit 

Input/Output Range window.
Note: The I/O range setting is based on your hardware configuration setting, you can have multiple 

hardware configuration settings, and this control may be locked in some configurations.

Hardware I/O Address
The hardware base I/O address is set using a block of DIP switches on the adapter circuit board. See your 
Hardware Installation documentation for instructions on how to set the DIP switches.
The software and hardware I/O address settings must match each other. For example, if you set the DIP 
switches to 180 (hex), you must select 180 (hex) in the software.

Technical Support
Comtrol has a staff of support technicians available to help you. 
You should review Troubleshooting and run through the diagnostics before calling Technical Support. In 

Peer Tracer Commands

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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addition, the web site has On-Line Technical Support available. If you call for Technical Support, please have 
the following information available.

Comtrol Headquarters Comtrol Europe
Internet URL: www.comtrol.com www.comtrol.co.uk
email: support@comtrol.com support@comtrol.co.uk
Phone: (763) 494-4100 +44 (0) 1 869-323-220
FAX: (763) 494-4199 +44 (0) 1 869-323-211
FTP site: ftp.comtrol.com
FAQ On-line Help: www.comtrol.com/coperate.htm

Disclaimer and Copyrights
Copyright © 2000. Comtrol Corporation. 
All Rights Reserved.
First Edition, October 30, 2000
Comtrol Corporation makes no representations or warranties with regard to the contents of this guide or to 
the suitability of the Comtrol products for any particular purpose. Specifications subject to change without 
notice. Some software or features may not be available at the time of publication. Contact your reseller for 
current product information.

Trademarks
RocketPort and RocketModem are registered trademarks and Comtrol is a trademark of Comtrol Corporation.
Microsoft, Windows, and Windows 2000 are registered trademarks of Microsoft Corporation.
Other product names mentioned herein may be trademarks and/or registered trademarks of their respective 
companies.
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Item Information

Hardware Type 

Hardware Serial Number*

Operating system type

Driver part number and revision level of Rocket.sys

Server computer make, model, and speed

Other serial port adapters installed in the server and 
their COM port numbers

Devices connected to the board
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